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Introduction 

WP3: Implementing SWPBS in primary schools 

Under the WP3 (“Getting off” the ground: Implementing SWPBS in primary schools), Cyprus partners 

implemented the experimental protocol for supporting student socio-emotional needs using the Tier 1 

SWPBS framework for 3 years (including project extension period). This report describes in detail the 

implementation of Tier 1 intervention in Cyprus school each year from the recruitment process until the 

preliminary analysis of data and extraction of conclusions. During this implementation quantitative and 

qualitative data were collected. Extensive data analysis and results examining the impact of the 

intervention and the overall attainment of project’s objectives throughout the 3-year period of reference 

are presented in the Final Evaluation Report (D5.5). Specifically, the aims of WP3 achieved by 

implementing Tier 1 intervention in Cyprus primary schools include: 

• Implement SWPBS Tiers 1 training manuals across school teams in Cyprus, 

• Coach and support school teams on SWPBS tiered implementation during project duration in 

Cyprus, 

• Provide professional development trainings to whole staff during project duration in Cyprus, 

• Collect empirical evidence on SWPBS impact and procedures. 

The information included in this report, along with reports prepared in other WPs (e.g., WP5: Evaluation) 

will be used to influence national and European policies and evidence-based practices on creating school-

wide learning environments with emphasis on safety, social inclusion and equity. 

The Tier 1 SWPBS theoretical framework 

School-wide Positive Behaviour Supports (SWPBS) is “an implementation framework for maximizing the 

selection and use of evidence-based prevention and intervention practices along a multi-tiered continuum 

that supports the academic, social, emotional, and behavioural competence of all students” (U.S. Office 

of Special Education Programs [OSEP], Technical Assistance Centre on Positive Behavioural Interventions 

and Supports, 2018, p.1). Extensive research knowledge base has been established in USA, where SWPBS 

has been researched and implemented for more than three decades reaching out to more than 26,000 

schools (OSEP, 2018) and acquiring an extensive knowledge base on SWPBS implementation, scalability 

and sustainability. So far, three meta-analyses have been conducted giving support to Tier 1 SWPBS 

positive impact on school outcomes (Mitchell, Hatton, Lewis, 2018; Chitiyo, May, & Chitiyo, 2012; Horner 

et al., 2010).  

The objective of SWPBS project is to develop, implement and experimentally study three -tiered Support 

for behavior problems in schools. The three-tiered support can be described as a preventative model, 

where the goal is to change the way school responds to problem behaviours. Tier 1 is called universal 

support or prevention and includes definition of school wide behaviours expectations, expected 
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behaviours in different school locations, teaching of the behaviours and reinforcing expected behaviours 

by positive feedback. In this project universal support were built to new schools in Cyprus, Greece and 

Romania whilst schools in Finland concentrated on developing Tier 2 and Tier 3 supports. 

SWPBS framework’s elements 

SWPBS aims to establish an inclusive non-discriminatory social culture and necessary socio-emotional and 

behavioural supports for all children in a school. It is a systems-change approach and NOT a packaged 

program or a social skill curriculum; it enhances the 

capacity of schools, families and communities to 

design effective and efficient learning environments 

that (a) address student needs by providing a 

continuum of supports; (b) monitor regularly the 

implementation of evidence-based practices (EBPs) 

and outcomes, and (c) follow data-based decision 

making through continuous data-collection process 

(Horner, Sugai, & Lewis, 2015). This systems-change 

approach requires at least 3-to-5-year investment to 

efficiently differentiate behavioural instruction for all 

students across three tiers, as presented in the above 

diagram (OSEP, 2017). 

Tier 1 support (Universal/Primary prevention) is built on the assumption that all children can exhibit 

appropriate behaviour. As a result, school staff is trained, coached and supported to assess the contextual 

setting events and environmental conditions and incorporate evidence-based practices and resources to 

increase the probability of appropriate behaviour. Teachers work to effectively teach, encourage and 

model school-wide values (e.g., respect, safety, responsibility) and appropriate behaviours (e.g., respect 

means use kind words and actions) to all children across all school areas (e.g., classroom, hallways, 

playground). Staff engage families and students in developing a universal positive and inclusive language 

about school’s vision and mission, identifying school-wide social values, teaching explicitly expected 

behaviours and routines, recognizing student and teacher positive behaviours, and providing corrective 

feedback on student social errors inside and outside of classrooms. Teachers are trained and supported 

through an active SWPBS leadership team and an external SWPBS coach. Families are encouraged to use 

the common language and social expectations at home. Current research evidence on Tier 1 points out 

the importance of implementing Tier 1 with fidelity prior to moving to Tiers 2 and 3 (Bradshaw, Reinke et 

al., 2008; Kim, McIntosh, & Hoselton, 2014). Doing so, it produces the maximum behavioural and 

academic outcomes for students. 

SWPBS is a systems-change framework that includes four main elements: 

1. Outcomes: these are the expected goals to be achieved after implementing each tier of support 

in a school. 
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2. Systems: include external and internal supports provided to strengthen adults’ behaviours in 

implementing SPWBS practices. Specifically, for Tier 1 implementation an external behavioural 

support coach provides on-site consultation and training to a SWPBS core team (leadership team). 

Training includes defining school vision and social values and expected positive behaviours, 

designing an instructional social skill approach to teach those behaviours, setting up a recognition 

system to reinforce student positive behaviours, designing a hierarchy of consequences to 

manage problem behaviours, and collecting data to make informed-based decisions with respect 

to student needs and procedural issues. The school leadership team, with the assistance of the 

external coach, trains and engages the rest of the school staff in putting the above elements in 

place.  School administration is actively involved and guiding the implementation process and 

ensuring for staff buy-in. 

3. Data: pertain to two sets of data (a) student data with 

respect to problem behaviours, attendance, academic 

achievement performance, and (b) fidelity of 

implementation. 

4. Practices: This element focuses on implementing 

evidence-based strategies to support student 

behaviour. For Tier I, practices include teaching, 

recognizing, correcting and re-teaching student social 

behaviours. All adults in a school are expected to follow 

a common instructional approach to promote school 

vision and values.  

SWPBS Tier 1 processes 

The first level of prevention (Tier 1) includes eight basic elements guiding the implementation. For a school 

to implement the intervention with fidelity and reach to impactful results must implement each one of 

the elements. The diagram below shows the problem-solving approach school teams will incorporate as 

they will be working towards building:  

• common school vision around creating positive school climate and developing positive student-

teacher relationships 

• common philosophy on discipline (i.e., emphasis on positive instructional approach to support 

student socio-emotional needs and problem behaviours rather than using reactive negative 

behavioural management strategies) 

• universal language on 3-5 school-wide expectations (e.g., “be tolerant” “be respectful” “be 

cooperative” “be responsible”) and behavioural rules (e.g., “be respectful waiting for your turn” 

“be responsible following directions” “be cooperative sharing materials”) 

• use of common social skill lesson plans to teach behavioural expectations in classroom and non-

classroom settings. All teaching staff gets involved in teaching behavioural lessons 
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• school-wide recognition system for acknowledging student performance on social expectations 

• use of hierarchy of consequences to discourage problem behaviours 

• use data to monitor student social performance and record student severe problem behaviours 

 

The SWPBS problem-solving framework provides teachers with evidence-based instructional practices 

and classroom management skills to create inclusive, positive classroom environments for all students. 

The project follows a systems-change approach, which means that the biggest impact on improving 

student behavioural and academic outcomes, school climate and teacher work satisfaction will come as a 

result after working with the entire school. In addition, the school becomes the “host environment” for 

preventing serious problems by training and coaching school to staff adopt and use evidence-based 

practices inside and outside of classrooms (e.g., Waasdorp et al., 2012). 

The implementation of Tier 1 Intervention in Cyprus 

Country Context 

The formal educational system of Cyprus is highly centralized with the Ministry of Education, Culture, 

Sports and Youth (MOECSY) being the authority for decision-making related to school finances, staff 
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recruitment and curriculum content. The majority of policies are top-down and limited liability is given to 

the regional offices or schools. However, as part of the recent educational reforms, schools are given some 

autonomy to conduct their own yearly needs assessment and develop a school-wide action plan in an 

effort to enhance school administrative and pedagogical effectiveness. At a policy level, systems to 

support students’ socio-emotional development and social behaviour are scarce. Therefore, the effective 

management of students’ inappropriate behaviours in the school remains a major challenge for teachers.  

During the academic year 2018/2019, for which the latest data are available, there were 361 primary 

education schools in Cyprus (330 public and 31 private schools). These schools employed 4.624 teachers 

(4.135 in public and 489 in private schools), serving 58.060 students (52.095 in public and 5.965 in private 

schools) in total. There is a great variation among schools in Cyprus.  

Related policies  

School Guide on Code of Conduct Against Racism: The Ministry of Education, Culture, Youth and Sports 

in Cyprus has developed a school guide, entitled “Code of Conduct Against Racism and Management of 

Racial Incidences”, which purports to provide information and prevention guidelines to school staff on 

human racism and how to identify, manage, and record incidences of racism in school. It constitutes a 

policy document, which comprises of two (2) parts that target primary and secondary education. The first 

part pertains to the Code of Conduct that addresses the rationale and importance of having such 

prevention school policies in place and states the responsibilities and commitments of each school 

member. The second part presents the management steps towards dealing with racism incidences, 

including the delivery of any punitive measures. School staff is asked to record each racism occurrence 

daily via the “Racism Incidence Recording Form” and annually via the “Annual Reporting Racism 

Incidences”.   

The general objectives of the “Code of Conduct Against Racism” are to: 

- Protect children’s rights, as defined by the International Convention on the Rights of the Child 

- Eliminate any kind of racism incidences 

- Support the provision of equal opportunities, justice and mutual respect 

- Support children, who may become victims of school violence 

Peer-Conflict Resolution: The Peer-Conflict Resolution program, offered by the Ministry of Education and 

Culture Cyprus, provides emphasis on training teachers on becoming mediators in peer-conflict 

incidences. Mediation is a process, which is applied for resolving conflicts. An individual (adults and 

students), who is properly trained, acts as a Mediator to help the conflicting parties to resolve their 

differences in a constructive manner. The most important characteristics of mediation are the Mediator’s 

communication skills, which he/she has to convey to all parties involved. A team of professionals from the 
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Ministry, known as the “Direct Intervention Team,” is responsible in providing in-service trainings and 

technical assistance to schools interested in implementing this program. 

The aim of this program is to minimize student tensions in school and thus cultivating a positive school 

climate. The specific objectives are the following: 

- Teach students communication skills, critical thinking and problem solving skills 

- Develop common school-wide approach to tackling peer confrontations  

- Reduce disciplinary referrals and penalties 

Direct Intervention Team: The Ministry of Education, Culture, Youth and Sports in Cyprus had set a priority 

to deal with the issue of preventing and addressing school violence. In 2008, the Minister had formed a 

Committee of Experts in order to plan actions towards addressing the phenomenon. One of the measures 

decided was to establish the “Direct Intervention Team” (DIT) in 2010. This team is comprised by multiple 

experts, such as educational psychologists and teacher secondments with expertise on crisis intervention. 

The DIT is responsible of supporting schools in managing severe cases of delinquency within the school 

premises.   Should schools need DIT’s services, they should submit a written request to DIT in order to 

seek support on severe student cases. Once DIT receives a school request, the case is being examined for 

action to be taken. The greater objective of the DIT is to support schools in addressing serious delinquent 

behaviours by designing an action plan to minimise the impact of chronic student behaviours. 

Setting up the ground 

Coaches’ role 

Each country was responsible for setting up an SWPBS coaches’ team during the first months of the project 

(M1-M6). The coaching team was in charge of training and coaching school staff to implement SWPBS 

elements at Tiers 1. Careful selection of qualified and capable individuals took place in each country, as it 

could impact our SWPBS intervention implementation and project outcomes. The Ministry/municipality 

partner collaborated with the research partner in each country to identify coaches, who should 

demonstrate evidence on these skills and qualifications: 

• Fluent with the scientific knowledge and use of SWPBS relevant concepts: Graduate degree 

(master’s or doctorate) in Special Education, School or Clinical Psychology, Applied Behaviour 

Analysis or related field. 

• Expertise in conducting adult education trainings for at least 2 years: Facilitate in-service teacher 

trainings, provide constructive feedback to teachers, participate in collaborative action planning, 

conduct staff training activities. 

• Fluent in oral and written English language: read research articles in English, participate in online 

group discussions with coaches from other countries, attend trainings conducted in English. 
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• Excellent interpersonal communication skills: Mediate conflicts and disagreements, facilitate 

school team meetings, manage teacher resistance, increase school staff buy-in in SWPBS, ability 

to work in groups and receive constructive feedback. 

• Fluent research and writing skills: adapt and write SWPBS intervention protocol and assessment 

tools in native language, develop school training slides in native language, search research 

literature, record and analyse data. 

• Experience and general fluency with technology: operate email, access and work on online 

platforms (Moodle), use word processing software. 

 

Each country assigned a supervisor (or coordinator) among external Tier 1 coaches. The following tasks 

took place: 

1. Meetings on a monthly as a coaching team to coordinate tasks with schools. 

2. Meetings online on a monthly basis (during the first year) with other European coaches and 

coordinators to receive professional development trainings and discuss challenges encounter in 

schools. 

3. Frequent visits on the online platform and partners shared folders to access resources and acquire 

material. 

Coaching team training and support 

Each country’s coaching team was formed and trained locally with their country coordinator, as well as 

centrally with all European coaches. An initial 3-day face-to-face training in Thessaloniki was conducted 

with all Tier 1 external coaches of partner countries. Consequently, coaches from Cyprus, Romania and 

Greece, with the supervision of Finnish partners, met online once a month to share concerns, to get more 

information on the intervention, acquire the training material and discuss for the implementation in their 

schools to agree on a common route. The online meetings took place at the following dates: 

1) Online Meeting 1 on the 9th September 2019 

2) Online Meeting 2 on the 23rd September 2019 

3) Online Meeting 3 on the 7th October 2019 

4) Online Meeting 4 on the 21st October 2019 

5) Online Meeting 5 on the 18th November 2019 

6) Online Meeting 6 on the 2nd December 2019 

7) Bilateral meetings in January 2020 

8) Online Meeting 8 on the 20th February 2020 

9) Online Meeting 9 in September 2020 

10) Online Meeting 10 on the 28th September 2020 

11) Online Meeting 11 on the 20th October 2020 

12) Online Meeting 12 on the 24th November 2020 

13) Online Meeting 13 on the 15th December 2020 
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14) Online Meeting 14 on the 13th January 2021 

15) Online Meeting 15 on the 10th February 2021 

16) Online Meeting 16 on the 24th March 2021 

17) Online Meeting 17 on the 21st April 2021 

18) Online Meeting 18 on the 1st November 2021 (CICO training) 

19) Online Meeting 19 on the 21st January 2022 (CICO training) 

20) Online Meeting 20 on the 25th March 2022 (CICO training) 

Regarding the local supervision and support among the local coaching team, coaches in Cyprus met at 

least once every month (either online or face-to-face) to discuss all issues, progress of schools and discuss 

everything with regards to implementation together. During the second year, all meetings and trainings 

had to take place online instead of face-to-face due to safety measures. In addition, external coaches 

created a common Viber group in order to effectively communicate daily and post all the questions and 

answers.  

Schools recruitment 

The process that Cyprus’ partners followed for the sample selection process was randomized, as per the 

project’s Experimental Protocol. On the 29th May 2019, Cyprus Pedagogical Institute (CPI) in collaboration 

with the Department of Primary Education (DPE) of the Ministry of Education, Culture, Sports and Youth 

(MECSY) published a circular, by which inviting up to 40 elementary schools to express a preliminary 

interest to participate in the SWPBS project. Following this, the CARDET Research Team met on the 23rd 

July 2019 with the CPI team. Both teams made decisions on the two following areas: (a) CPI sent out an 

email notification to all school principals of primary schools that expressed their interest to participate in 

the SWPBS project at the end of August 2019, in order to verify again with them about the receipt of their 

electronic submission interest, and, (b) CARDET Research Team contacted via phone each school principal 

to set up a 2-hour meeting with school staff to present the project idea and provide opportunities for 

discussion and further clarifications. 

From September until mid –October 2019, external coaches of the Cyprus SWPBS team contacted schools 

to present the SWPBS idea and the whole process of working with the team across the 2-year 

implementation. Out of the 62 schools across the cities of Nicosia, Larnaca and Ammochostos, which had 

the chance to be given out the presentation, a total of 33 schools’ staff (at least 70%) voted positively for 

their participation in the project. All schools signed an agreement that outlined their role and 

responsibilities for participating in the project.  

All 33 schools participated in a draw of 5 consecutive rounds and based on the majority of results (e.g. if 

a school was picked more times for the A Group rather than the B Group), the teachers were assigned in 

two groups: Group A (Experimental Group) or Group B (Control Group). Participating schools vary in size, 

location (rural and urban areas), and region (Nicosia, Larnaca and Famagusta). The table below presents 

the sample schools overall demographics that participated in Years 1, 2 and 3. 
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Table 1. Participating schools’ demographics 

Year Group A Group B 
Total no. of 

teachers 

Total no. of 

students 

Students in 

Special Ed. 

Students in 

Speech 

Therapy 

Year 1 

(2019 – 2020) 
16 17 604 5801 329 321 

Year 2 

(2020 – 2021) 
16 15 564 5224 357 297 

Year 3 

(2021 – 2022) 
15 279 2433 186 n/a 

Note. Demographics of each school in each year are presented in Annexes 1, 2, and 3. 

Overall, 33 schools joined the project in September 2019 and 31 schools remained in October 2020, after 

2 schools dropped out (in early 2020). The main reasons for dropping are the following: 

1) Collaboration among school staff proved to be a key factor for the project’s successful 

implementation, while they mentioned that some school staff members were opposed to 

implementing the system. 

2) The schools that dropped out mentioned that the system requires a heavy workload on behalf of 

the schools. 

3) New staff joined the schools during the second year, which did not wish to proceed with the 

project implementation. 

Therefore, 31 schools continued with the implementation of SWPBS Tier 1 during the second year. 

Consequently, due to the strongly willingness of certain school to continue for a third year, Cyprus partner 

decided to support them in this effort. In this respect, a new recruitment cycle followed asking the 31 

schools to express their interest for a third year of implementation. From this pool of schools, 15 

responded positively and brought on board for a new year. The project extension (i.e., for six months until 

August 2022) helped in this process as support given by the research and coaching team fell under the 

duration of the programme. The type of training and support provided during all years is described in the 

following section. 

Schools’ trainings and ongoing support 

Coaches in Cyprus were assigned certain schools to support and be generally responsible for the 

implementation of Tier 1 in their context. During the first year of implementation, all meetings and 

trainings were to be held face-to-face, while in the second year of implementation, all meetings and 
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trainings were held online. However, due to covid-19 the f2f interaction interrupted in March 2019. Coach 

mainly engaged with schools in four different ways: 

• Trainings to the School Leadership Team (SLT) 

• Whole School Staff (WSS) Trainings 

• Monthly meetings 

• Ongoing support and communication 

During the first year of implementation (2019-2020), 15 schools were supported actively by the coaching 

and research team (experimental group). During the second year of implementation (2020-2021), the 

other 16 schools received the same trainings. During the third year, 15 schools from both group continued 

the intervention and provided training/support. The School Leadership Team (SLT) Trainings (Annex 4) 

were held in 2 or 3 groups of schools by the local external coaches collectively, with the following themes: 

1) Establishing staff buy-in (defining school vision and new philosophy of discipline, identifying 2-3 

school-wide expectations) 

2) Defining expected behaviours (developing school-wide matrix across settings by including 1-2 

social behaviours per school-wide expectation and setting) and social skill instruction activities 

3) Developing a school-wide acknowledgment system 

4) Correcting problem behaviours and introducing TFI 

5) Developing school’s action plan based on TFI fidelity assessment 

The Whole School Staff (WSS) Trainings (Annex 5) were held once a month with each school by the 

responsible coach in collaboration with the coordinator of the very school’s SLT, as follows: 

(a) creating positive learning environments (here we emphasize on building positive relationships at 

school) to be a joint presentation between principal and external coach 

(b) teaching school-wide expectations and social skills (i.e., expected social behaviours) in the 

classroom to be a joint presentation between external coach and internal coach 

(c) specific positive feedback (i.e., behavior specific praise and correcting student behavior) to be a 

joint presentation between external coach and internal coach 

(d) error correction procedure to be a joint presentation between external coach and internal coach. 

Monthly meetings (Annex 6) were also pursued to keep up with the implementation progress, inform 

about the next steps and discuss issues or concerns that might arise. These meetings started to take place 

face-to-face with external coaches visiting each of their schools. However, these meetings were soon 

interrupted with the covid-19 outbreak. In addition, schools were holding their own internal agenda which 

was discussed at least once month (or more frequently) during their predefined weekly meetings among 

teaching staff. The following table summarizes the quantity and duration of schools’ training and support. 

However, ongoing and instant communication (e.g., phone calls, chats, email) are not observable. Last, 

additional seminars on irrelevant subjects were provided to the control groups as per the experimental 

protocol (Annex 7). 
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Table 2. Trainings and meetings provided during the project 

 Trainings to the 

School 

Leadership 

Team (SLT) 

(*hours) 

Whole School 

Staff (WSS) 

Trainings 

(*hours) 

Monthly 

meetings with 

the external 

coach (*hours) 

Monthly within 

school meetings 

(*hours) 

Year 1 

(Sep. 2019 - Jun. 2020) 

10 (*3hrs) 

f2f 

64 (*1hr) 

f2f & online 

≈100 (*1hr) 

f2f & online 

≈20 (*0.5hr) 

f2f 

Year 2 

(Sep. 2020 - Jun. 2021) 

10 (*3hrs) 

online 

54 (*1hr) 

online 

≈100 (*1hr) 

online 

≈20 (*0.5hr) 

f2f 

Year 3 

(Sep. 2021 - Jun. 2022) 

4 (*1.5hrs) 

online 

≈50 (*1hr) 

ad hoc / online 

≈20 (*0.5hr) 

f2f 
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Implementation map 

     
YEAR 1 

     
Sep-19 Oct-19 Nov-19 Dec-19 Jan-20 Feb-20 Mar-20 Apr-20 May/19 Jun-20 

         M7 M8 M9 M10 M11 M12 M13 M14 M15 M16 

Intervention Group A                           

  Group B                           

SLT trainings Group A 15 hrs (f2f) Group A     1 2   3 & 4 5       

  Group B                           

WSS trainings Group A 8hrs (f2f) Group A                     

  Group B                           

Monthly meetings Group A 4-8 meetings (1hr) Group A                     

  Group B                           
 Lockdown                    
 Data collection                   
 TFI                   

 

     
YEAR 2 

     Sep-20 Oct-20 Nov-20 Dec-20 Jan-21 Feb-21 Mar-21 Apr-21 May-21 Jun-21 

        M19 M20 M21 M22 M23 M24 M25 M26 M27 M28 

Intervention Group A                         

  Group B                         

SLT trainings Group A   -                     
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  Group B 10hrs (online) Group B     1 2 3 4 5       

WSS trainings Group A   -                     

  Group B 8hrs (online) Group B                     

Monthly meetings Group A 1-8 meetings (1hr) Group A                     

  Group B 6-8 meetings (1hr) Group B                     
 Lockdown                 
 Data collection                   
 TFI                   

 

     
YEAR 3 

     Sep-21 Oct-21 Nov-21 Dec-21 Jan-22 Feb-22 Mar-22 Apr-22 May-22 Jun-22 

        M31 M32 M33 M34 M35 M36 M37 M38 M39 M40 

Intervention Group A                         

  Group B                         

SLT trainings Group A   -                     

  Group B   -                     

WSS trainings Group A 
6hrs Group C (15 schools) 

    

  

    

  

    

  

  

  Group B               

Monthly meetings Group A 
where requested  

                      Group B 
 Lockdown               

 Data collection                 
 TFI                 
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Experimental design 

Research questions 

According to the research design, the participated primary schools from three countries (Cyprus, Greece, 

Romania) implemented a randomized wait-list controlled experimental design. Experimental procedures 

in Year 1 included randomizing schools into intervention (Group A) and control group (Group B), and offer 

the SWPBS and Business as usual interventions, respectively. In Year 2, Group A schools continued SWPBS 

intervention for 2nd year, while Group B was offered the SWPBS intervention. Four main research 

questions were preliminary set based on the evaluation plan as follows: 

1. What are the effects of Tier 1 intervention on student and teacher outcomes? 

2. To what extent can schools implement Tier I with fidelity with a professional development manual?  

3. What factors (i.e., external coaches’ experience from year 1 to year 2, external coaches’ pre/post 

evaluation skills, external coaches’ contact with schools, school demographics) moderate progression 

toward fidelity? 

4. How does progress toward fidelity impact teacher perceptions of collective teacher efficacy and 

classroom behavioural climate? 

Data Collection Procedures 

Phases and Instruments 

According to the experimental protocol, research measures were administered 4 times. However, due to 

COVID-19 the 2nd data collection was postponed due to the covid-19 outbreak as shown below. Due to 

the continuation of the project for a third year, the partnership decided to collect data at the end of that 

academic year as an additional measurement. The data collection phases are presented below: 

• 1st phase of data collection: Oct-Nov 2019 

• 2nd phase of data collection: May-Jun 2021 (postponed) 

• 3rd phase of data collection: Oct-Nov 2020 

• 4th phase of data collection: May-Jun 2021 

• 5th phase of data collection: May-Jun 2022 

Instruments selection was made on the basis of previous research experiences. The behavior problem 

scale selected (Gray & Sime, 1989) is one that has been used in two largest experimental studies in Europe 

(PALS study in Norway, ProSchool study in Finland). The scale has student (10 items) and teacher (13 

items) versions and describes different types of problem behaviours ranging from mild (e.g., being noisy) 

to severe (e.g., physical violence) problem behaviours. The scale is used as a sum score of problem 

behaviours as it has been found to be a reliable overall problem behavior indicator in earlier studies. 
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Classroom behavior climate measure was developed for the Finnish ProSchool study and proved to be a 

reliable and valid scale (see Närhi et al. 2015, 2017) and has been translated since to German (Hoffman 

et. al 2021). Classroom behavioural climate has four sub-dimensions: positive learning climate, 

disruptions, safety, caring for environment. 

In addition, students wellbeing was measured in a short questionnaire probing their well-being from six 

different angles. This questionnaire is adapted from the Finnish version of HBSC study (Kämppi et al. 2012) 

and used also in the ProSchool study and found to be a good and concise scale having 3 items per subscales 

of: emotional engagement, workload in school, feeling of justice, student relations, student-parent 

relationship, student-teacher relationship.  

Teachers rated also their collective teacher efficacy and the overall school climate. Collective efficacy was 

selected as an outcome since earlier studies in Norway and Finland have found that SWPBS had positive 

effects on teacher collective efficacy. Both studies have used the Collective Teacher Beliefs Scale 

(Tschannen-Moran & Barr, 2004) which has two sub-dimensions, instructional strategies and student 

discipline. School climate was chosen as an outcome as one of the objectives of SWPBIS is to develop 

overall working culture in a school. The Revised School Level Environment Questionnaire (Johnson et al. 

2007) has been used in ProSchool research (see e.g. Malinen & Savolainen, 2016) and other studies in 

Finland and has four subscales in this study: collaboration, student relations, decision making and 

instructional innovation.  

In brief, the following measures were administered to participating schools in each research phase 

according to the Experimental Protocol. From a random sample of students from Grades 4 and 5 in each 

research phase from both research groups (Grade 4= 9-10 years old; Grade 5=10-11 years old) except 

from Grades 5 and 6 during the 5th measurement. 

1. Student evaluation of classroom behavioural climate (Närhi et al., 2015)  
2. Student behavioural problems in school (Grey & Sime, 1989)  
3. Social relationship quality and well-being (Kämppi et al., 2012)  

From all teachers of participating schools from both groups are assessed: 

1. Teachers evaluation of Classroom behavioural climate (Närhi et al., 2015)  
2. Teacher evaluations on behavioural problems in school (Grey & Sime, 1989)  
3. Organizational health and school climate (Johnson et al., 2007) 
4. Teacher Collective efficacy (Tschannen-Moran & Barr, 2004)  

Background information were also collected from both teachers (gender, age, teaching experience, formal 

education) and students (gender, age). 

As a measure on the implementation fidelity of the intervention, the Tiered Fidelity Inventory (TFI) Tool 

was also administered in each phase: 
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• Modified TFI for Tier 1 implementation (see 

https://www.pbisapps.org/Applications/Pages/Tiered-Fidelity-Inventory-(TFI).aspx). The TFI 

assessment, included the following measurements: 

a. Interviews of at least 20% school staff 

b. Interviews of at least 10% of all students 

c. 10-minute Interview from the School Principal 

d. School Observation 

For the translation of the above instruments we used the European Social Survey (ESS) translation 

guidelines (Dorer, 2016) as part of the TRAPD procedures. TRAPD is an acronym for Translation, Review, 

Adjudication, Pre-testing and Documentation, the five interrelated procedures which form the framework 

for ESS translation and assessment (Harkness, 2003). These cover the basic procedures involved in 

producing a final translated version of a questionnaire. 

Data coding and processing 

As per the research coordinator guidelines, at the end of each data collection phase, partner countries 

followed the same procedure to entering and coding the data. All data were first recorded in excel 

documents until imported to IBM SPSS statistics 20 program and organized separately by each country 

and measurement occasion. 

The data from all countries was first cleaned to check for duplicate codes for individuals and any variable 

values outside the expected range (typically caused by mistakes in coding). The overall quality of the data 

was very good and only a few corrections were needed. After necessary corrections were made, for 

example to reverse some negatively measured items so that calculation of reliability is meaningful. After 

the check of reliabilities summary variables were formed from all subscales. All data transformations were 

made with SPSS Syntax (Annex 8) saved in a file so that if need arise to make changes in variables, the 

whole process can be easily repeated. Then, student and teacher datasets were merged and aggregated 

where possible (Annex 9). 

For the time initial analyses of means and standard deviations and 95% confidence interval of the means 

were conducted for all time periods. In addition, calculations of Intra Class correlations (ICC) were made 

with SPSS variance components function to assess whether there is between school variance in the major 

outcome.  Having Intra Class Correlations that are large enough are necessary for running two level models 

(random intercept models) which use individual (teacher) or class-level (students) data but have the 

primary interest in testing outcomes at the school level, which is the primary unit of analysis in a School 

Wide implementation. ICCs for the problems behavior variables for teacher and student ratings are 

reported here. 

 

https://www.pbisapps.org/Applications/Pages/Tiered-Fidelity-Inventory-(TFI).aspx)
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Study sample 

At the beginning of the school year 2019-20, the Cyprus team invited 33 primary schools to participate in 

the study. From all the invited schools, 2073 students from Grade 4 and Grade 5 participated in the 

research. The student sample at the initial measure came from 472 classrooms. These students come 

from two groups: the experimental group (n=1019) and the control group (n=1054). Randomization was 

done at the school level to avoid any spill over effect. The number of female and male students in the 

experimental group was 511 (51%) and 508 (49%) respectively. Also, the number of female and male 

students in the control group was 509 (48.3%) and 545 (51.7%) respectively. As regards the ages of 

students, the mean was 9.4 (SD= .67) of those in the experimental group and 9.5 (SD= .63) of those in the 

control group. Data on students’ perceptions were collected not only at the beginning of the school year 

2019-20, but also at the beginning of the school year 2020-21 which was our second measurement. As 

already mentioned, we were not able to conduct the second data collection at the end of the first school 

year due to the closures of schools because of the COVID-19 pandemic. It is important to note that 

although 2073 students from Cyprus participated in the initial measurement, 1330 students participated 

in the second measurement and 1241 in the third measurement which was conducted at the end of the 

school year 2020-21. Comparison of the background characteristics between the experimental and the 

control groups was also conducted in all three measurements revealing no significant differences. 
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Table 3. Students’ demographics participated in research 

 T1 T2 T3 T4 

Students (n, %)     

Group A 1019 (49.2%) 657 (49.4%) 645 (52.0%) 337 (65.6%) 

Group B 1054 (50.8%) 673 (50.6%) 596 (48.0%) 177 (34.4%) 

Total 2073 1330 1241 514 

Gender (n, %)     

Group A     

Male 508 (49.0%) 305 (46.4%) 299 (46.4%) 71 (40.1%) 

Female 511 (51.0%) 351 (53.4%) 346 (53.6%) 105 (59.3%) 

Group B     

Male 545 (51.7%) 338 (50.2%) 299 (50.2%) 146 (43.3%) 

Female 509 (48.3%) 335 (49.8%) 297 (49.8%) 189 (56.1%) 

Age (M, SD)     

Group A 9.4 ( .67) 9.5 ( .71) 10.0 ( .80) 10.7 (.98) 

Group B 9.5 ( .53) 9.6 ( .61) 10.0 ( .70) 11.1 (.73) 

The number of female and male teachers in the experimental group was 219 (88%) and 30 (12%) 

respectively. Also, the number of female and male teachers in the control group was 196 (89.1%) and 24 

(10.9%) respectively. As regards the ages of teachers, the mean was 47.72 (SD= 6.48) of those in the 

experimental group and 42.16 (SD= 6.50) of those in the control group. Data on teacher perceptions were 

collected not only at the beginning of the school year 2019-20, but also at the beginning of the school 

year 2020-21 which was our second measurement. As already mentioned, we were not able to conduct 

the second data collection at the end of the first school year due to the closures of schools because of the 

COVID-19 pandemic. In particular, it is important to note that due to the circumstances, a significant 

number of teachers and students were not able to participate in the intervention from March 2020 till the 

end of the school year. Although 473 teachers from Cyprus participated in the initial measurement, only 

406 teachers participated in the second measurement and 401 in the third measurement, which was 

conducted at the end of the school year 2020-21. Comparison of the background characteristics between 
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the experimental and the control groups was also conducted in all three measurements revealing no 

significant differences. 

Table 4. Teachers’ demographics participated in research 

 T1 T2 T3 T4 

Teachers (n, %)     

Group A 251 (53.1%) 201 (50.5%) 217 (54.1%) 93 (48.9%) 

Group B 222 (46.9%) 205 (49.5%) 184 (45.9%) 97 (51.1%) 

Total 473 406 401 190 

Gender (n, %)     

Group A     

Male 30 (12.0%) 19 (9.4%) 26 (11.9%) 11 (11.8%) 

Female 219 (88.0%) 184 (90.6%) 192 (88.1%) 81 (87.1%) 

Group B     

Male 24 (10.9%) 23 (11.4%) 13 (7.2%) 8 (8.2%) 

Female 196 (89.1%) 179 (88.6%) 168 (92.8%) 85 (87.6%) 

Age (M, SD)     

Group A 47.72 (6.48) 43.2 (6.32) 43.62 (6.49) 44.09 (6.10) 

Group B 42.16 (6.50) 42.84 (6.69) 42.65 (6.37) 43.16 (6.84) 

Experience (M, 
SD) 

   
 

Group A 19.05 (8.51) 19.95 (8.21) 19.31 (8.91) 19.66 (8.81) 

Group B 18.73 (8.36) 18.77 (8.66) 18.34 (8.79) 19.38 (9.75) 

Years at school 
(M, SD) 

   
 

Group A 2.86 (3.32) 2.67 (2.54) 2.98 (2.67) 3.55 (4.69) 
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Group B 2.50 (2.54) 2.22 (1.64) 2.73 (1.76) 2.73 (1.84) 

Education level (n, 
%) 

 
 

 
 

Group A     

Bachelor 89 (40.2%) 73 (36.1%) 75 (34.4%) 32 (34.4%) 

Master 141 (55.3%) 117 (57.9%) 129 (59.2%) 52 (55.9%) 

PhD 19 (4.6%) 11 (5.4%) 11 (5.0%) 7 (7.5%) 

Other 0 1 ( .5%) 3 (1.4%) 0 

Group B     

Bachelor 88 (35.7%) 71 (35.1%) 59 (32.6%) 33 (34.0%) 

Master 121 (56.6%) 120 (59.4%) 113 (62.4%) 55 (56.7%) 

PhD 10 (7.6%) 10 (5.0%) 8 (4.4%) 5 (5.2%) 

Other 0 1 ( .5%) 1 ( .6%) 1 (1.0%) 

Preliminary key findings 

The results and progression of the TFI assessment in each participating school are presented in Annex 10. 

Overall there is positive progression of the fidelity implementation of the intervention from the schools 

that engage with the intervention every year. More details on the differences between groups and the 

statistically significant differences of TFI scores in each school are given in the Final Evaluation Report. In 

total, four (4) TFI assessments were conducted in October 2019, October 2020, May-June 2021, May-June 

2022 and May 2021 along with the student and teacher data collections. 

The key findings including in-depth analysis of the observed outcomes and addressing the research 

questions as presented above, are presented in the Evaluation Reports. While it is clear that there have 

been some challenges in receiving data from all the schools in the second measurement carried out in 

autumn 2020, the overall longitudinal data set will be large enough for credible longitudinal analyses. This 

holds both for the student and teacher samples. Though the student and teacher data shows: 

• There is ample data for longitudinal analyses that are most likely to be used with this type of data 
(Repeated measures ANOVA, Regression analysis, Cross-Lagged longitudinal analysis (SEM)). (see 
column N in above tables). 

• The datasets are quantitatively comparable among them. 
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• Point estimates of means across time and their 95% Confidence Intervals suggest that there are 
differences in the average levels of some of the observed outcomes. This is promising, as we may 
be able to detect some changes towards a positive direction i.e., reduction in problem behaviours, 
increase of school climate, student wellbeing, collective teachers’ efficacy etc. that may be 
attributed to the intervention. However, this observation should not be interpreted as an 
intervention effect at this point, because: 

o preliminary analyses do not differentiate between experimental and control group. 
o The samples across measurements are not matched, thus differences may be a result of 

differential sampling at different time periods. 

Initial analyses of scale reliabilities in the three countries suggest the vast majority of subscales show good 

to excellent reliability. In some rare instances specific subscales reliabilities are lower but acceptable. 

Some individual country adjustments to some individual subscales may also have to be made (e.g., 

omission of problematic single items) after a thorough analysis of what might be the linguistic or cultural 

reasons that have likely caused the lack of fit of an item. In summary, the overall conclusion at this point 

is that the selected scales will provide reliable information from all three countries and the result in this 

regard is excellent, as some of the scales had not been previously used in all three countries. 

Any data collected from schools is not only individual level data, as the respondents are clustered. For 

example, teachers give their individual rating but they are also clustered within schools. Actually in this 

study we are specifically interested in this share of variance that is variance between schools, as we wish 

to detect intervention effects at the school level. Students are clustered in classes within schools. Students 

data is anonymous in this study so for majority of traditional analysis data aggregated for classroom level 

(classroom mean) will be used, but even there much interest lies also in analysing the share of variance 

between schools and whether this variance can be explained by for example the fidelity of intervention.  

The initial analysis of Intra Class Correlations shows that there is meaningful school level variance with 

the exception of student data in T1 in Cyprus and Teacher data in T2 in Romania. Otherwise it will be 

possible to test the fit of Two-level Structural equation models (SEM) where the school level variance and 

its statistical significance and dependency on relevant predictors (e.g., intervention group, intervention 

fidelity, demographic variables) can be tested. 

Conclusion 

The implementation of the School-Wide Positive Behaviour Support (SWPBS) framework in Cyprus 

brought involved stakeholders in front of a new reality. The PBS intervention is a long-duration school-

wide applied systemic approach which requires continuous efforts from school actors for 3-4 consecutive 

school years. It is based on belief systems and values often opposed to the traditional approaches for 

student behaviour management and discipline. In Cyprus, beside the countless activities produced to 

support and execute such a large-scale project, people required to formulate a different thinking which 

opened-up new prospects and ideas. The ongoing work of key people involved in Cyprus was 

indispensable for shifting the perceptions and beliefs of the wider group networks including researches, 
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coaches, schools, teachers, students, parents, partner organisations, and higher level associates (e.g., 

local authorities, policy-makers etc.). This process becomes easier when recommendations are backed up 

with robust data and a 3-year practical experience. This report summarizes the implementation of the 

SWPBS as done by the Cyprus partner teams, which depicts the volume and quality of activities taken 

throughout the project lifespan as well as performance indications about the project impact based on the 

research observed outcomes. 

During the preparation phase, Cyprus partners engaged in gaining robust knowledge on the theoretical 

framework of the SWPBS approach. They reviewed scientific articles that describe the implementation 

process in other educational systems and research approaches that examined the impact of the 

intervention at schools in other contexts. After mapping the favourable condition for implementing the 

SWPBS, Cyprus partners proceeded with an extensive needs analysis on the national primary schools 

collecting data from school inspectors, teachers, and school principals. The assessment focused on 

identifying the current local needs on school-wide discipline prevention and student socio-emotional 

supports and mapping the existing preventing policies/programmes for student discipline and behaviour 

management. The national research team based on the data collected during the needs assessment 

process, drafted a national report which resulted in guidelines and recommendations on developing 

action plans around school-wide prevention support systems for strengthening students’ socio-emotional 

development. 

Following the review of the literature and the needs assessment, Cyprus partners recruited the SWPBS 

coaching team based on certain criteria concerning the educational, professional background and field 

experience working at/with schools. The coaching team initially attended the intensive formal trainings 

provided by the research coordinator and the ongoing meetings along with the coaching team of other 

countries throughout the project lifespan. In total, apart from the initial f2f intensive training in Greece, 

20 official transnational coaching meetings were conducted during the project. Bilateral and informal 

communication through video conferences, emails and chat was also encouraged. Within country 

communication and support was also very regular, especially during the first year. This way a network of 

external coaches across the participating countries was developed in an excellent climate of collaboration 

and mutual support. The internal capacity building gatherings continued throughout the project 

intervention within a spirit of lifelong learning mindset. The Cyprus research teams along with the local 

external coaches contributed to the development of the SWPBS Tier 1 training manual, which was 

extensively used by schools and teachers during the intervention phase. After the first year of 

implementation and the identification of several basic challenges, coaches contributed to the 

development of the first version of the Coaching and Professional Development manual for future coaches 

and members that joined the team at a later stage. Along with the manuals, coaches during the 

preparation phase produced the training material (i.e., presentations, educational aids, guidelines, 

checklists etc.) to be used during the intervention period. 

During the recruitment phase, the Cyprus Pedagogical Institute (CPI) in collaboration with the Department 

of Primary Education (DPE) of the Ministry of Education, Culture, Sports and Youth (MECSY) published a 
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circular inviting primary schools from three geographical districts (Nicosia, Larnaca, Ammochostos) to 

express their interest to participate in the SWPBS project. Upon guidelines of the CPI, 62 schools verified 

their interest through an electronic submission. CARDET delivered a 2-hour presentation of the SWPBS 

project to the school staff of each of the interested schools during the period September-October 2019, 

followed by a brief discussion and further clarifications. A total of 33 schools voted positively to participate 

in the project (with at least 80% of internal agreement). According to the project requirements 30 schools 

were supposed to participate, though all schools signed an agreement with Cyprus partnership, in which 

their role and responsibilities for participating in the project were outlined. The schools were randomized 

divided into two groups: 15 schools as Group A (Experimental Group) and 17 schools Group B (Control 

Group). Demographic details were collected with all participating schools and a preliminary training plan 

was agreed with the school management teams. Simultaneously, the ethics clearance approval was 

obtained for schools to participate on the programme allowing visits from the external coaches and the 

research team to collect data from teachers and students at schools. Parent consent forms were required 

every school year in order to provided questionnaires to students. 

The first year of intervention (2019-2020) began with a great excitement, however, it was subjected to 

the unavoidable barrier of covid-19 pandemic. During the first months (i.e., October and mid-November 

2019), data collection preceded any action either in experimental and control schools. Members from the 

research team visited schools and handed questionnaires to each participating classroom (i.e., students 

of all 4th and 5th grades). It was emphasized that only students with parent consent participated answering 

the questionnaires. At the same time, the teacher questionnaires were administered by the school 

management team to the teaching staff. Experimental schools (group A) were given priority time-wise as 

after this process, they should have begun with the trainings and the implementation of the intervention. 

Coaches started with the school leadership team (SLT) training. These trainings were organised in three 

groups of schools based on their region. Until December 2019, experimental schools (group A) received 

two SLT trainings and the SWPBS leadership team was formed at each school. The SWPBS leadership team 

is a group comprised of 4-5 teachers, members of the school management team and parents if possible, 

that would lead the implementation of the SWPBS intervention at their school. Their role during the 

project were very important. In January, the SWPBS leadership team with the assistance of the school 

coach began with delivering training to the school staff (i.e., whole school staff trainings - WSS). These 

trainings were conducted separately at each school during the predetermined monthly whole-school 

meetings. Simultaneously, monthly meetings were taking place at each school with the SWPBS leadership 

team and the school coach. The purpose of these meetings is to keep schools on track with the 

intervention, monitor their progress and provide instant support. In total, 5 SLT trainings, 4 WSS trainings, 

and meetings every month were to be conducted during the first year of implementation to the 

experimental schools (group A). This plan worked smoothly until March 2020 when the covid-19 outbreak 

imposed strict safety measures. All public schools closed during the 2nd and 3rd week of the month. In two 

groups of schools the last (5th) SLT training were held online. Similarly, the last (4th) WSS training and the 

upcoming monthly meetings were held online. However, school for three consecutive months (March-

May 2020) were unable to implement any of the steps of the SWPBS framework in practice. Beside the 
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back office work, teachers were only able to teach some of the social skills and routines online which at 

the end were not applied or reinforced because of the distance learning model. Therefore, we conclude 

that only some of the first main elements were actually implemented in practice, even though teachers 

made considerable efforts preparing material and the ground of a normal-running implementation. The 

research team evidenced the positive attitudes of schools towards the programme and teachers’ 

willingness to integrate it into their policy and practice. Schools reopened a few weeks before the official 

summer holidays, however, because of the strict safety measures imposed by the government, external 

visits to schools were prohibited. Therefore, the 2nd data collection phase was postponed. In sum, the 

covid-19 stroke when the practical steps of the SWPBS framework were about to emerge, which limits to 

the minimum the impact of the intervention at experimental schools. It is also noted that during the first 

year three trainings/seminars/workshops were provided to the control schools (group B) in topics 

irrelevant to the project to keep them engaged throughout the first year. Though one school from the 

control group dropped out from the programme. 

After the pandemic crisis, the situation at schools was far from the normal with regards to the second 

year of the intervention (2020-2021). Teachers and students were stressed and hesitant towards the 

uncertain conditions. Schools run to prepare the ground for a possible second lockdown and to cover the 

curriculum of last year. Local lockdown started to take place were students of teachers found to be 

positive incidents of covid-19. Generally, the situation was far from the normal circumstances. The 

research team and coaches attempted to use the project framework as an alleviating factor for schools 

stressed situation by developing small positive moments as tailored to the project mission. During the 

first two months (September and October 2020), the research team after granting an official permission 

from the Ministry of Education and the ethical approval for the research measures, visited the schools 

and handed questionnaires to students (of 4th and 5th grades) and teachers. Consequently, in November 

2020 coaches begun the with the SLT trainings to group B schools. These trainings were conducted online 

in groups as during the first year. Until March 2021, coaches delivered 5 SLT trainings to SWPBS school 

leadership teams as planned (i.e., one training per month). At the same time, WSS trainings took place 

online since December 2020 to the teaching staff of each school by the SLT with the assistance of the 

school’s coach. As planned, four WSS were held at each school and completed until April 2021. 

Unfortunately, apart from the local lockdowns because of the covid-19 (at certain schools or classrooms 

for unknown time periods) throughout the school year, another universal lockdown took place after 

December 2020 extending the Christmas holidays by the end of January 2021. This is expected to have 

again a negative impact on the normal and smooth implementation of the project at schools. However, 

adjusting to the new reality the trainings were all held online. Along with the trainings, monthly online 

meetings were taking place with the SLT and the school’s coach for ongoing monitoring and assistance. 

Group A schools were also assisted by their coach when requested. For this reason, there is some variation 

on the monthly meeting of Group A monthly meeting during year 2. As per coaches’ communication with 

schools and as evidenced during the fidelity measurement all schools continued with the intervention 

implementation and feedback from all schools was positive. During the last months of the school year 

(May and June 2021) the 3rd data collection phase took place normally. All ethical approval documents, 
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consent forms, as well as safety measures were considered. It is also noted that one school dropped out 

at the beginning of the year 2. 

Several schools requested to the research team to continue implementing the SWPBS framework for 

another year (2021-2022). Although not included in the project proposal requirements, all countries 

agreed to offer some form of assistance to schools that willing to continue implementing the SWPBS 

framework. In Cyprus, the CPI circulate an announcement to the 31 participating schools as a call of 

interest for implementing the framework for a third year. Fifteen (15) schools expressed their interest 

therefore the research team and coaches actively supported them. Three universal online WSS trainings 

were conducted to the schools’ staff throughout the school year. In addition, ad hoc support was provided 

by coaches to schools during the school year. Following the longitudinal research approach of the project, 

the research team conducted a 4th measurement of outcome to examine the long-term effect of the 

SWPBS intervention. Therefore, data were collected during the May and June 2022. No lockdowns were 

imposed and the negative effect of covid-19 was minimal during the 3rd year. 

Following the request of specific cases, the research team pilot implemented the Tier 2 support in two 

schools in year 3 during the months February-May 2022. The Cyprus research team identified and selected 

2 primary schools that demonstrated at least 80% adherence to the experimental protocol, as measured 

by the School-wide Evaluation Tool (Horner et al., 2004). In total, eight students (four in each school) were 

provided additional Tier 2 support, as non-responsive to Tier 1. As per the CICO support, involved teachers 

provided regular support (re)teaching daily routines and organising the supporting environment with high 

fidelity. In addition, schools collected information concerning the intervention effects. More information 

about the implementation of the Tier 2 support and its results can be found in the relevant report1. 

Along with the development of project administrative deliverables, the research team used several results 

during the intervention such as the teacher manuals and the e-learning platform. SWPBS Tier 1 and 2 

training manuals (D2.1 & D2.2), as well as the coaching and professional development manual (D2.3) were 

revised based on the experience and feedback of involved people (coaches, teachers, school principals, 

students, parents, research teams). This feedback is available in the piloting reports (D2.4 & D2.5). All the 

evidence concerning the implementation of Tier 1 & Tier 2 interventions in Cyprus can be found in the 

relevant folders (D3.1 & D3.2). The overall experience of the SWPBS framework implementation is 

attempted to be shown in the final project promo video (D3.3). The project online platform (D4.1) is a 

dedicated space to host all final deliverables and materials produced by schools during the project. These 

resources are expected to be extremely useful to schools implementing or intended to implement the 

SWPBS framework. Access is open upon registration. This platform also hosts the online course (D4.2), a 

specifically designed e-learning set of modules regarding the theoretical and practical aspect of the SWPBS 

framework. Moreover, the Cyprus partners collaborated to develop the digital tool (D4.3) for data 

collection of minor and major inappropriate behaviours incidents at schools. The desktop application was 

also pilot tested in four participating schools in Cyprus. The application is available upon request and 

 

1 SWPBS_D3.2 Implementation report for SWPBS Tier 2_Cyprus 
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extensive details about the process can be found in the relevant report. Also, the video tutorial and 

demonstration is available here. 

Cyprus partners will continue to collaborate with the research teams of the other participating countries 

for analysing and extracting more conclusions about the effect of the intervention during the last years. 

The rich dataset will be also used after the project for drafting scientific articles for publication to 

academic peer-reviewed journals and scientific conferences in Europe and beyond. Though partners 

worked collaboratively to produce the Evaluation reports (D5.2-D5.5) which give a comprehensive picture 

on the measures and the impact of the intervention in the four countries. Extensive statistical data analysis 

is available along the presenting the methodology followed (i.e., sampling, intervention design, measures 

etc.). The overall results were also presented in the project Final Conference (D6.5) which was held in 

Cyprus to the participants including the Minister of Education, the director of the CPI, officials from key 

office authorities, researchers and teachers of all education levels. The feedback was very promising 

regard the actions that the public authorities will take to sustain and expand the implementation of the 

SWPBS framework in schools around Cyprus. The project results utilization actions are comprehensively 

presented in the Exploitation plan (D6.6) which summarizes the intended activities of all partner countries. 

During the project lifespan, several quality assurance controls took place ensuring that challenges are 

faced effectively by the consortium. Cyprus partners took part in all quality assurance evaluations (D8.2-

D8.5) and participated in the meetings with active decision making in front of risks and challenges. Last, 

according to the sustainability strategies and mission of the partnership, Cyprus partners collected and 

reported the relevant data (D9.1) assisting to the development of policy and practice guidelines (D9.2). 

Cyprus partners are very proud for the implementation of the project considering the large scale positive 

impact evidenced from the quantitative and qualitative data analysed during the project. In addition, the 

comments received from schools were encouraging and demonstrated the actual impact for teachers and 

students. Cyprus partners are committed to take actions in the future for sustaining the intervention and 

developing supportive mechanisms for further schools to adopt the SWPBS framework. 

  

https://www.youtube.com/watch?v=4tMx-NzUkxc
https://pbiseurope.org/en/about/outputs/swpbs-european-conference
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Annexes 

Annex 1. School Demographics for schools in Year 1 

Table 5. School Demographics for schools in Year 1 

School Code 
N 

Students 
N 

Teachers 

N 

not native 
speakers 

N 

SEN Children 

(SE – Special 
Education 

ST – Speech 
Therapy) 

Urban/Rural 

Group A 

61 (Agios 
Demetrios) 

296 26 49 
43 

(23 SE + 20 ST) 
Urban 

62 (Anthoupoli) 103 13 8 
27 

(14 SE + 13 ST) 
Urban 

63 (Aradippou E) 315 28 20 
32 

(23 SE + 9 ST) 
Urban 

64 (Archangelos) 271 25 12 
29 

(11 SE + 18 ST) 
Urban 

65 (Dasoupoli KB) 190 20 27 
18 

(12 SE  + 6 ST) 
Urban 

66 (Kokkinotrim. A) 151 19 27 
47 

(23 SE + 24 ST) 
Rural 

67 (Lymbia) 209 21 12 
20 

(10 SE + 10 ST) 
Rural 

68 (Nareg) 97 16 N/A 
5 

(2 SE + 2 ST) 
Urban 
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69 (Sia) 56 9 1 
11 

(6 SE +5 ST) 
Rural 

70 (Frenaros) 284 26 58 
31 

(12 SE + 19 ST) 
Rural 

71 (Kornesios) 262 26 31 
22 

(16 SE + 6 ST) 
Urban 

72 (AglangiaD) 195 14 5 
8 

(3 SE + 5 ST) 
Urban 

73 (LakatameiaD) 269 21 81 
21 

(8 SE + 13 ST) 
Urban 

74 (Meniko) 72 13 7 
20 

(13 SE  +  7 SL) 
Rural 

75 (Paliomet.) 90 15 7 
11 

(5 SE + 6 ST) 
Rural 

76 (Sotira B) 155 18 23 
28 

(13 SE + 15 ST) 
Rural 

Group B 

77 (Mitsero) 54 10 14 8 

(6 SE + 2 ST) 
Rural 

78 (Ag Dometios) 135 19 33 15 

(5 SE + 10 ST) 
Urban 

79 (AgMarina) 13 4 0 0 Rural 

80 (Vrysoules) 98 12 14 24 

(11 SE + 13 ST) 
Rural 

81 (Evrychou) 81 13 9 28 

(14 SE + 14 ST) 
Rural 

82 (Livadia) 270 24 3 29 

(26 SE + 3 ST) 
Rural 
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83 (Mazotos) 49 8 21 6 

(4 SE + 2 ST) 
Rural 

84 (Mammari) 146 15 34 14 

(7 SE + 7 ST) 
Rural 

85 (XylofagouB) 201 20 34 24 

(13 SE + 11 ST) 
Rural 

86 (AglangiaSt) 293 27 35 24 

(11 SE + 13 ST) 
Urban 

87 (Akaki) 178 19 24 30 

(16 SE + 14 ST) 
Rural 

88 (Alethriko) 143 17 11 24 

(13 SE + 11 ST) 
Rural 

89 (Apost. 
Varnavas) 

209 21 53 23 

(12 SE + 11 ST) 
Urban 

90 (Ergates) 90 12 37 27 

(12 SE + 15 ST) 
Rural 

91 (LakatameiaE) 312 27 N/A N/A Urban 

92 (Makedonitis) 389 34 7 32 

(15 SE + 17 ST) 
Urban 

93 (Prodromos KB) 125 12 63 24 

(13 SE + 11 ST) 
Urban 
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Annex 2. School Demographics for schools in Year 2 

Table 6. School Demographics for schools in Year 2 

School Code 
N 

Students 

N 

Teachers 

N 

not native 

speakers 

N 

SEN Children 

SE – Special Education 

ST – Speech Therapy 

Urban/Rural 

Group A 

61 (Agios Demetrios) 311 30 49 
40 

(24 SE + ST 16) 
Urban 

62 (Anthoupoli) 130 17 15 
27 

(22 SE + 15 ST) 
Urban 

63 (Aradippou E) 302 26 17 
62 

(34 SE  +  28 ST) 
Urban 

64 (Archangelos) 269 25 3 
28 

(11 SE + 17 ST) 
Urban 

65 (Dasoupoli KB) 186 20 17 
32 

(24 SE  +  8 ST) 
Urban 

66 (Kokkinotrim. A) 149 18 N/A N/A Rural 

67 (Lymbia) 201 22 7 
19 

(9 SE + 10 ST) 
Rural 

68 (Nareg) 91 17 5 
3 

(2 SE +1 ST) 
Urban 

69 (Sia) 55 12 2 
10 

(5 SE + 1 ST) 
Rural 
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70 (Frenaros) 266 25 15 
31 

(20 SE + 11 ST) 
Rural 

71 (Kornesios) 254 25 Not given Not given Urban 

72 (AglangiaD) 191 17 Not given Not given Urban 

73 (LakatameiaD) 272 20 7 
23 

(13 SE + 16 ST) 
Urban 

74 (Meniko) 67 12 6 
19 

(6 SE  +  13  ST) 
Rural 

75 (Paliomet.) 90 15 6 
12 

(4 SE + 8 ST) 
Rural 

76 (Sotira B) 147 17 22 
22 

(8 SE + 14 ST) 
Rural 

Group B 

77 (Mitsero) 46 8 13 10 

(6 SE + 4 ST) 
Rural 

78 (Ag Dometios) 135 20 22 28 

(11 SE + 17 ST) 
Urban 

79 (AgMarina) 11 4 0 5 

(2 SE+ 3 ST) 
Rural 

80 (Vrysoules) 99 12 9 

 

29 

(14 SE + 15 ST) 
Rural 

81 (Evrychou) 90 14 N/A N/A Rural 

82 (Livadia) 270 24 3 29 

(26 SE + 3 ST) 
Rural 
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83 (Mazotos) 49 8 21 6 

(4 SE + 2 ST) 
Rural 

84 (Mammari) 143 17 26 17 

(7 SE + 10 ST) 
Rural 

85 (XylofagouB) 218 24 48 47 

(32 SE + 15 ST) 
Rural 

86 (AglangiaSt) 275 27 8 26 

(14 SE + 12 ST) 
Urban 

87 (Akaki)* - - - - - 

88 (Alethriko) 143 17 11 24 

(13 SE + 11 ST) 
Rural 

89 (Apos. Varnavas) 197 21 19 23 

(11 SE + 13 ST) 
Urban 

90 (Ergates) 88 13 33 34 

(15 SE + 19 ST) 
Rural 

91 (LakatameiaE)* - - - - - 

92 (Makedonitis) 354 21 2 35 

(20 SE + 15 ST) 
Urban 

93 (Prodromos KB) 125 16 N/A N/A Urban 

Note. Primary schools of Akaki and Lakatameia E dropped out the second year. 
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Annex 3. School Demographics for schools in Year 3 

Table 7. School Demographics for schools in Year 3 

School Code 
N 

Students 
N 

Teachers 

N 

not native 
speakers 

N 

SE – Students in 
Special Education 

Urban/Rural 

Group A 

61 (Agios Demetrios) 327 31 N/A 27 Urban 

66 (Kokkinotrim. A) 139 19 N/A 19 Rural 

68 (Nareg) 85 15 N/A 1 Urban 

69 (Sia) 57 11 N/A 10 Rural 

72 (AglangiaD) 193 17 N/A 7 Urban 

75 (Paliomet.) 92 14 N/A 5 Rural 

76 (Sotira B) 150 18 N/A 11 Rural 

Group B 

78 (Ag Dometios) 138 20 N/A 8 Urban 

79 (AgMarina) 14 5 N/A 2 Rural 

81 (Evrychou) 86 14 N/A 13 Rural 

82 (Livadia) 280 23 N/A 25 Rural 

85 (XylofagouB) 225 24 N/A 19 Rural 

88 (Alethriko) 132 15 N/A 13 Rural 

89 (Apos. Varnavas) 167 22 N/A 8 Urban 

92 (Makedonitis) 348 31 N/A 18 Urban 

Note. Primary schools of Akaki and Lakatameia E dropped out the second year. 
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Annex 4. School Leadership Team (SLT) trainings in Cyprus 

Table 8. School Leadership Team (SLT) trainings in Cyprus 

Training Date 
F2F or 
online 

Duration Nature 

Group A - Year 1 

1st School Leadership Team Training 17.11.2019 F2F 3 hours Formal 

1st School Leadership Team Training 19.11.2019 F2F 3 hours Formal 

1st School Leadership Team Training 20.11.2019 F2F 3 hours Formal 

2nd School Leadership Team Training 03.12.2019 F2F 3 hours Formal 

2nd School Leadership Team Training 04.12.2019 F2F 3 hours Formal 

2nd School Leadership Team Training 06.12.2019 F2F 3 hours Formal 

3rd & 4th School Leadership Team Training 05.02.2020 F2F 3 hours Formal 

3rd & 4th School Leadership Team Training 06.02.2020 F2F 3 hours Formal 

3rd & 4th School Leadership Team Training 07.02.2020 F2F 3 hours Formal 

5th School Leadership Team Training 06.03.2020 F2F 3 hours Formal 

5th School Leadership Team Training 18.03.2020 Online 1,5 hour Formal 

5th School Leadership Team Training 19.03.2020 Online 1,5 hour Formal 

Group B - Year 2 

1st School Leadership Team Training 17.11.2020 Online 2 hours Formal 

1st School Leadership Team Training 19.11.2020 Online 2 hours Formal 

1st School Leadership Team Training 20.11.2020 Online 2 hours Formal 

2nd School Leadership Team Training 15.12.2020 Online 2 hours Formal 

2nd School Leadership Team Training 17.12.2020 Online 2 hours Formal 
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2nd School Leadership Team Training 18.12.2020 Online 2 hours Formal 

3rd School Leadership Team Training 19.01.2021 Online 2 hours Formal 

3rd School Leadership Team Training 21.01.2021 Online 2 hours Formal 

3rd School Leadership Team Training 22.01.2021 Online 2 hours Formal 

4th School Leadership Team Training 26.02.2021 Online 2 hours Formal 

4th School Leadership Team Training 25.02.2021 Online 2 hours Formal 

5th School Leadership Team Training 18.03.2021 Online 2 hours Formal 

5th School Leadership Team Training 19.03.2021 Online 2 hours Formal 

Group A & B - Year 3 

1st School Leadership Team Training 12.10.2021 Online 1.5 hour Formal 

1st School Leadership Team Training 14.10.2021 Online 1.5 hour Formal 

2nd School Leadership Team Training 02.11.2021 Online 1.5 hour Formal 

3rd School Leadership Team Training 08.02.2022 Online 1.5 hour Formal 

4th School Leadership Team Training 17.05.2022 Online 1.5 hour Formal 

Note. The School Leadership Team (SLT) trainings were conducted in groups based on the 
geographical area. 
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Annex 5. Whole School Staff (WSS) trainings in Cyprus 

Table 9. Whole School Staff (WSS) trainings in Cyprus 

School 1st 2nd 3rd 4th 

Group A -Year 1 

61 (Agios Demetrios) 27.01.2020 03.02.2020 17.02.2020 16.03.2020 

62 (Anthoupoli) 27.11.2019 19.02.2020 30.04.2020 28.05.2020 

63 (Aradippou E) 16.12.2020 03.02.2020 24.02.2020 30.03.2020 

64 (Archangelos) 18.12.2019 29.01.2020 12.02.2020 18.03.2020 

65 (Dasoupoli KB) 20.01.2020 27.01.2020 17.02.2020 - 

66 (Kokkinotrim. A) 22.01.2020 05.02.2020 04.03.2020 04.03.2020 

67 (Lymbia) 18.12.2019 15.01.2020 19.02.2020 08.04.2020 

68 (Nareg) 11.12.2019 10.02.2020 19.02.2020 11.03.2020 

69 (Sia) 20.01.2020 17.02.2020 24.02.2020 - 

70 (Frenaros) 16.12.2019 20.01.2020 24.02.2020 23.03.2020 

71 (Kornesios) 27.01.2020 17.02.2020 - - 

72 (AglangiaD) 13.01.2020 10.02.2020 24.02.2020 30.03.2020 

73 (LakatameiaD) 15.01.2020 29.01.2020 19.02.2020 11.03.2020 

74 (Meniko) 13.01.2020 13.01.2020 10.02.2020 - 

75 (Paliomet.) 10.12.2019 21.01.2020 25.02.2020 17.03.2020 

76 (Sotira B) 16.12.2019 10.02.2020 09.03.2020 30.03.2020 

Group B – Year 2 

77 (Mitsero) 13.01.2021 17.02.2021 24.03.2021 07.04.2021 

78 (Ag Dometios) 21.12.2020 27.01.2021 08.03.2021 19.04.2021 
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79 (AgMarina) 07.12.2021 13.01.2021 18.02.2021 26.03.2021 

80 (Vrysoules) 09.12.2020 03.02.2021 03.03.2021 07.04.2021 

81 (Evrychou) 09.12.2020 27.01.2021 10.02.2021 13.03.2021 

82 (Livadia) 07.12.2020 11.01.2021 28.01.2021 05.04.2021 

83 (Mazotos) 15.01.2021 15.01.2021 05.02.2021 02.04.2021 

84 (Mammari) 02.12.2020 13.01.2021 03.02.2021 10.03.2021 

85 (XylofagouB) 30.11.2020 18.01.2021 22.02.2021 29.03.2021 

86 (AglangiaSt) 02.12.2020 27.01.2021 03.03.2021 07.04.2021 

87 (Akaki)* - - - - 

88 (Alethriko) 21.12.2020 12.01.2021 23.02.2021 06.04.2021 

89 (Apos. Varnavas) 18.01.2021 01.02.2021 01.03.2021 05.04.2021 

90 (Ergates) 20.01.2021 24.02.2020 31.03.2021 21.04.2021 

91 (Lakatameia E)* - - - - 

92 (Makedonitis) 30.11.2020 18.01.2021 01.02.2021 29.03.2021 

93 (Prodromos KB) 19.01.2021 19.01.2021 - - 

Group A & B – Year 3 

All schools 14.10.2021 02.11.2021 08.02.2022 17.05.2022 

Note. Primary schools of Akaki and Lakatameia E dropped out the second year. 

 

  



 

 

 

www.pbiseurope.org 

Annex 6. Monthly meetings of schools with their external coach 

Table 10. Monthly meetings of schools with their external coach 

School 1st 2nd 3rd 4th 5th 6th 7th 8th 

Group A – Year 1 

61 (Agios 
Demetrios) 

11.12.2019 13.01.2020 27.01.2020 17.02.2020 13.03.2020 06.04.2020 - - 

62 (Anthoupoli) 21.11.2019 09.12.2019 17.01.2020 14.02.2020 07.03.2020 24.04.2020 08.05.2020 12.06.2020 

63 (Aradippou E) 10.12.2019 14.01.2020 11.02.2020 10.03.2020 07.04.2020 12.05.2020 - - 

64 (Archangelos) 29.11.2019 24.01.2020 14.02.2020 13.03.2020 - - - - 

65 (Dasoupoli KB) 18.11.2019 10.12.2019 13.01.2020 13.02.2020 09.03.2020 02.04.2020 04.05.2020 04.06.2020 

66 (Kokkinotrim. A) 26.11.2019 10.12.2019 14.01.2020 11.02.2020 03.03.2020 - - - 

67 (Lymbia) 21.11.2019 18.12.2019 15.01.2020 12.02.2020 11.03.2020 08.04.2020 06.05.2020 03.06.2020 

68 (Nareg) 20.11.2019 12.12.2019 23.01.2020 13.02.2020 12.03.2020 03.04.2020 - - 

69 (Sia) 20.11.2019 18.12.2019 10.02.2020 - - - - - 

70 (Frenaros) 21.11.2019 16.12.2019 20.01.2020 14.02.2020 13.03.2020 10.04.2020 08.05.2020 05.06.2020 

71 (Kornesios) 22.12.2019 09.12.2019 20.01.2020 17.02.2020 16.03.2020 27.04.2020 25.05.2020 - 

72 (AglangiaD) 22.11.2019 11.12.2019 15.01.2020 10.02.2020 18.03.2020 08.04.2020 06.05.2020 - 

73 (LakatameiaD) 22.11.2019 19.11.2019 24.01.2020 21.02.2020 20.03.2020 27.04.2020 15.05.2020 05.06.2020 

74 (Meniko) 28.11.2019 19.12.2019 16.01.2020 13.02.2020 - - - - 

75 (Paliomet.) 28.11.2019 19.12.2019 13.02.2020 05.03.2020 30.04.2020 - - - 

76 (Sotira B) 21.11.2019 13.12.2019 10.01.2020 14.02.2020 13.03.2020 10.04.2020 08.05.2020 - 

Group A – Year 2 

School 1st  2nd  3rd  4th  5th  6th  7th  8th  9th  

61 (Agios 

Demetrios) 

04.09.2020 05.10.2020 19.10.2020 16.11.2020 15.02.2021 22.03.2021 24.05.2021 - - 

62 

(Anthoupoli) 

08.10.2020 21.10.2020 05.11.2020 20.11.2020 03.12.2020 11.03.2021 27.05.2021 - - 

63 (Aradippou 

E) 

16.10.2020 - - - - - - - - 
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64 

(Archangelos) 

09.10.2020 06.11.2020 27.11.2020 04.12.2020 05.02.2021 11.02.2021 21.05.2021 - - 

65 (Dasoupoli 

KB) 

07.12.2020 - - - - - - - - 

66 

(Kokkinotrim. 

A) 

09.10.2020 21.10.2020 04.12.2020 11.02.2021 02.04.2021 - - - - 

67 (Lymbia) 14.10.2020 27.11.2020 12.02.2021 09.04.2021 - - - - - 

68 (Nareg) 27.10.2020 09.11.2020 10.11.2020 18.11.2020 08.12.2020 09.02.2021 23.02.2021 - - 

69 (Sia) 26.11.2020 11.02.2021 17.02.2021 14.04.2021 - - - - - 

70 (Frenaros) 07.10.2020 26.10.2020 04.11.2020 02.12.2020 27.01.2021 17.02.2021 26.05.2021 - - 

71 (Kornesios) 19.10.2020 02.12.2020 10.12.2020 17.02.2021 14.04.2021 - - - - 

72 (AglangiaD) 10.09.2020 21.10.2020 25.11.2020 03.02.2021 24.03.2021 02.06.2021 - - - 

73 

(LakatameiaD) 

26.10.2020 04.12.2020 15.02.2021 - - - - - - 

74 (Meniko) 30.09.2020 21.10.2020 11.11.2020 - - - - - - 

75 (Paliomet.) 08.10.2020 24.09.2020 22.10.2020 26.10.2020 12.11.2020 17.12.2020 20.01.2021 18.03.2021 03.06.2021 

76 (Sotira B) 02.10.2020 05.10.2020 23.10.2020 30.10.2020 26.02.2021 28.05.2021 - - - 

Group B – Year 2 

School 1st 2nd 3rd 4th 5th 6th 7th 8th 

77 (Mitsero) 25.11.2020 21.12.2020 27.01.2021 03.03.2021 24.03.2021 14.04.2021 19.05.2021 02.06.2021 

78 (Ag Dometios) 25.11.2020 21.12.2020 27.01.2021 03.03.2021 24.03.2021 - - - 

79 (AgMarina) 17.11.2020 18.12.2020 22.01.2021 26.02.2021 19.03.2021 23.04.2021 25.05.2021 04.06.2021 

80 (Vrysoules) 25.11.2020 16.12.2020 27.01.2021 17.02.2021 07.04.2021 21.04.2021 - - 

81 (Evrychou) 30.11.2020 21.12.2020 25.01.2021 01.03.2021 22.03.2021 07.04.2021 12.05.2021 07.06.2021 

82 (Livadia) 30.11.2021 21.12.2020 25.01.2021 01.03.2021 29.03.2021 - - - 

83 (Mazotos) 26.11.2020 22.12.2020 26.01.2021 02.03.2021 06.04.2021 - - - 

84 (Mammari) 27.11.2020 18.12.2020 22.01.2021 05.02.2021 05.03.2021 02.04.2021 14.05.2021 04.06.2021 

85 (XylofagouB) 27.11.2020 21.12.2020 19.02.2021 05.03.2021 02.04.2021 - - - 

86 (AglangiaSt) 02.12.2020 22.12.2020 22.01.2021 25.02.2021 03.03.2021 07.04.2021 - - 
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87 (Akaki) - - - - - - - - 

88 (Alethriko) 24.11.2020 04.01.2021 29.01.2021 02.03.2021 26.03.2021 16.04.2021 25.05.2021 18.06.2021 

89 (Apos. Varnavas) 03.12.2020 14.01.2021 28.01.2021 04.03.2021 16.03.2021 08.04.2021 13.05.2021 15.03.2021 

90 (Ergates) 24.11.2020 18.12.2021 26.01.2021 09.03.2021 23.03.2020 13.04.2021 18.05.2021 01.06.2021 

91 (LakatameiaE) - - - - - - - - 

92 (Makedonitis) 24.11.2020 15.01.2021 26.01.2021 02.03.2021 23.03.2021 20.04.2021 - - 

93 (Prodromos KB) 11.12.2020 19.01.2021 - - - - - - 

Group A & B – Year 3 

All schools 14.10.2021 02.11.2021 08.02.2022 17.05.2022 - - - - 

Note. Primary schools of Akaki and LakatameiaE dropped out the second year 
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Annex 7. Additional Seminars for control group at Year 1 

Table 11. Additional Seminars for control group at Year 1 

School 1st 2nd 3rd 

Group B – Year 1 

77 (Mitsero) 22.01.2020 05.02.2020 20.05.2020 

78 (Ag Dometios) 10.02.2020 17.02.2020 25.02.2020 

79 (AgMarina) 16.01.2020 12.03.2020 14.05.2020 

80 (Vrysoules) 15.01.2020 - - 

81 (Evrychou) 22.01.2020 18.03.2020 06.05.2020 

82 (Livadia) - - - 

83 (Mazotos) 28.01.2020 11.02.2020 19.05.2020 

84 (Mammari) 22.01.2020 12.02.2020 13.05.2020 

85 (XylofagouB) 27.01.2020 24.02.2020 04.05.2020 

86 (AglangiaSt) 18.12.2019 26.02.2020  

87 (Akaki) 15.01.2020 19.02.2020 13.05.2020 

88 (Alethriko) 28.01.2020 18.02.2020 07.04.2020 

89 (Apos. Varnavas) 03.02.2020 16.03.2020 06.04.2020 

90 (Ergates) 15.01.2020 26.02.2020 20.05.2020 

91 (LakatameiaE) 29.01.2020 19.02.2020 06.05.2020 

92 (Makedonitis) 22.01.2020 12.02.2020 13.05.2020 

93 (Prodromos KB) 29.01.2020 - - 
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Annex 8. Syntax file: Variables calculation 

Teacher data 

1. Problem behaviours in school 

COMPUTE 

BehaviorProblemsT1=mean(Beh1@1,Beh2@1,Beh3@1,Beh4@1,Beh5@1,Beh6@1,Beh7@1,Beh

8@1,Beh9@1, Beh10@1,Beh11@1,Beh12@1,Beh13@1). 

2. Classroom behavioural climate 

RECODE Cbc4@1 Cbc10@1 Cbc11@1 Cbc13@1 Cbc16@1 (1=6) (2=5) (3=4) (4=3) (5=2) (6=1). 

• 'Positive learning climate' 

COMPUTE PosWorCliT1=mean(Cbc1@1,Cbc2@1,Cbc3@1,Cbc4@1). 

• 'Disruptions'_REV 

COMPUTE DisruptT1=mean(Cbc5@1,Cbc6@1,Cbc7@1,Cbc8@1,Cbc9@1). 

• 'Safety' 

COMPUTE SafetyT1=mean(Cbc10@1,Cbc11@1,Cbc12@1,Cbc13@1,Cbc14@1). 

• 'Caring for environment' 

COMPUTE CareEnvT1=mean(Cbc15@1,Cbc16@1,Cbc17@1). 

3. School climate 

RECODE Schc7@1 Schc8@1 Schc11@1 Schc13@1 Schc16@1 Schc17@1 (1=5) (2=4) (3=3) (4=2) 

(5=1). 

• 'Collaboration' 

COMPUTE 

CollaborationT1=Mean(Schc1@1,Schc5@1,Schc9@1,Schc13@1,Schc16@1,Schc17@1). 

• 'Student relations' 

COMPUTE StudentRelT1=Mean(Schc2@1,Schc6@1,Schc10@1,Schc14@1). 

• 'Decision Making' 

COMPUTE DecisionMakingT1=Mean(Schc3@1,Schc7@1,Schc11@1). 

• 'Instructional innovation' 

COMPUTE InstuctInnovT1=Mean(Schc4@1,Schc8@1,Schc12@1,Schc15@1). 

4. Teacher collective efficacy 

• 'Instructional Strategies' 

COMPUTE ColEfInstructionT1=Mean(Tcef1@1,Tcef2@1,Tcef5@1,Tcef6@1,Tcef9@1,Tcef11@1). 

• 'Behavior management' 

COMPUTE ColEfBehManT1=Mean(Tcef3@1,Tcef4@1,Tcef7@1,Tcef8@1,Tcef10@1,Tcef12@1). 

Student data 

1. Problem behaviours in school  

COMPUTE 

BehProbT1=mean(Last1@1,Last2@1,Last3@1,Last4@1,Last5@1,Last6@1,Last7@1,Last8@1,Las

t9@1, Last10@1). 
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2. Classroom behavioural climate  

RECODE Less1@1 Less2@1 Less3@1 Less4@1 Less6@1 Less15@1 Less16@1 Less18@1 

Less21@1 (1=4) (2=3) (3=2) (4=1). 

• 'Positive working climate' 

COMPUTE 

PosWorCliT1=mean(Less1@1,Less2@1,Less3@1,Less4@1,Less6@1,Less7@1,Less8@1,Less9@1)

. 

• 'Disruptions' 

COMPUTE DisruptT1=mean(Less5@1,Less10@1,Less11@1,Less12@1,Less13@1,Less14@1). 

• 'Safety' 

COMPUTE SafetyT1=Mean(Less15@1,Less16@1,Less17@1,Less18@1,Less19@1). 

• 'Caring for the environment' 

COMPUTE CareEnvT1=Mean(Less20@1,Less21@1,Less22@1). 

3. Student well-being 

RECODE Schc4@1 Schc5@1 Schc6@1 Schc8@1 (1=5) (2=4) (3=3) (4=2) (5=1). 

COMPUTE WellbeingallT1=Mean(Schc1@1, Schc2@1, Schc3@1, Schc4@1, Schc5@1, Schc6@1, 

Schc7@1, Schc8@1, Schc9@1, Schc10@1, Schc11@1, Schc12@1, Schc13@1, Schc14@1, 

Schc15@1, Schc16@1, Schc17@1, Schc18@1). 

• 'Emotional school engagement' 

COMPUTE EmoEngT1=Mean(Schc1@1,Schc2@1,Schc3@1). 

• 'Work load' 

COMPUTE WorkLoadT1=Mean(Schc4@1,Schc5@1,Schc6@1). 

• 'Feeling of Justice' 

COMPUTE JusticeT1=Mean(Schc7@1,Schc8@1,Schc9@1). 

• 'Student relations' 

COMPUTE StuRelT1=Mean(Schc10@1,Schc11@1,Schc12@1). 

• 'Family relations' 

COMPUTE FamRelT1=Mean(Schc13@1,Schc14@1,Schc15@1). 

• ‘Teacher relations' 

COMPUTE TeachRelT1=Mean(Schc16@1,Schc17@1,Schc18@1). 
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Annex 9. Preparation of datasets and merging of longitudinal data 

If cases can be matched (i.e. Teachers data): 

1. Recode reversed variables and Compute summary variables for each measurement (i.e., copy 

Syntax file into the command area: File → New → Syntax [change needed for each measurement: 

@1 and T1, @2 and T2, @3 and T3). Save file. 

Attention: Check for duplicate entries within every measurement 

• Data → Sort cases (by Key variable) 

• Data → Identify Duplicate cases 

o If you identify duplicates (see output, and top of Data view) 

▪ Correct the (teacher) code if it is wrong with either one of the 

duplicate 

▪ Changing the line of data to correct file if it has been misplaced 

(like last time) 

▪ Confirming which is the right data and deleting the incorrect one 

2. Merge data (Data → Merge files → Add variables): 

a. Key variable: Identify the key variable that will be used to merged data, which is unique 

for each case in each measurement (i.e. Teacher code). 

b. Identical variables: Other variables’ name should be differentiated among measurements 

(i.e., by adding at the end @1, @2, @3). 

3. The merged file is ready (i.e., Teachers_T1_T2_T3). Save file. 

4. Aggregated the data in another level if appropriate (e.g., school level). 

a. Data → Aggregate → Break variable (i.e., School code [aggregate level]) → Summaries of 

variables (Add the variables needed [demographics, background, and summary variables] 

→ “Create a new dataset containing only …” → ok. Save file 

If cases cannot be matched (i.e. Students data): 

1. Recode reversed variables and Compute summary variables for each measurement (i.e., copy 

Syntax file into the command area: File → New → Syntax [change needed for each measurement: 

@1 and T1, @2 and T2, @3 and T3). Save file. 

Attention: Check for duplicate entries within every measurement 

• Data → Sort cases (by Key variable) 

• Data → Identify Duplicate cases 
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2. Aggregate data before merging the files: You need to aggregate the data to a level of a unique 

value for case (i.e., Class code): 

a. Data → Aggregate → Break variable (i.e., Class code [aggregate level]) → Summaries of 

variables (Add the variables needed [demographics, background, and summary variables] 

→ “Create a new dataset containing only …” → ok. Save file 

3. Merge data (Data → Merge files → Add variables): 

a. Key variable: Identify the key variable that will be used to merged data, which is unique 

for each case in each measurement (i.e. Class code). 

b. Identical variables: Other variables’ name should be differentiated among measurements 

(i.e., by adding at the end @1, @2, @3). 

4. The merged file is ready (i.e., Students_T1_T2_T3agg). Save file. 
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Annex 10. TFI Assessment progress in participating schools 

Table 12. TFI Assessment progress in participating schools 

School Code T1 T2 T3 T4 

Group A 

61 (Agios Demetrios) 6 20 30 18 

62 (Anthoupoli) 6 16 21 - 

63 (Aradippou E) 0 19 27 - 

64 (Archangelos) 2 19 27 - 

65 (Dasoupoli KB) 0 6 23 - 

66 (Kokkinotrim. A) 0 15 16 14 

67 (Lymbia) 0 14 23 - 

68 (Nareg) 1 8 14 12 

69 (Sia) 3 15 25 25 

70 (Frenaros) 4 16 29 - 

71 (Kornesios) 0 17 21 - 

72 (AglangiaD) 0 13 24 24 

73 (LakatameiaD) 0 14 15 - 

74 (Meniko) 0 19 26 - 

75 (Paliomet.) 0 20 27 28 

76 (Sotira B) 4 15 29 24 

Group B 

77 (Mitsero) 0 4 23 - 
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78 (Ag Dometios) 0 6 22 29 

79 (AgMarina) 3 5 26 15 

80 (Vrysoules) 3 8 30 - 

81 (Evrychou) 0 3 24 24 

82 (Livadia) 0 7 26 25 

83 (Mazotos) 0 3 24 - 

84 (Mammari) 0 3 30 - 

85 (XylofagouB) 3 10 29 23 

86 (AglangiaSt) 3 5 23 - 

87 (Akaki)* 0 - - - 

88 (Alethriko) 4 10 26 27 

89 (Apos. Varnavas) 1 4 18 18 

90 (Ergates) 1 3 17 - 

91 (LakatameiaE)* 0 - - - 

92 (Makedonitis) 0 3 24 16 

93 (Prodromos KB) 2 3 15 - 

 


